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Engineers face challenging test scenarios 

when developing RF and Microwave products, 

especially those using complex signaling or 

those expected to make measurements in noisy 

environments.  To address these challenges,

engineers need new methods and tools to effec-

tively test these signals.

One emerging test method involves continuous 

acquisition of digitized data, otherwise known 

as “streaming” data, where the data is captured

and stored in memory or on disk for detailed 

processing and analysis during or after the 

acquisition.

The most effective test setup depends on the 

details of your application:

 Frequency range and signal bandwidth

 Required sampling rate and resolution

 Expected duration of the acquisition
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Engineers require tools to overcome the challenges of 

capturing gapless data and quickly locate the target 

signal from the data record for analysis. The solution, 

presented in this application note, includes easy-to-use 

interfaces that help with recording to disk, accessing the 

disk to process the data, and provides the capability to 

peruse and analyze the data. 

This application note outlines how to best employ the 

Agilent M9392A PXI Microwave Vector Signal Analyzer 

with 100 MHz streaming capability, including a radar 

measurement example.

Abstract

The Agilent M9392A PXI Microwave Vector Signal 

Analyzer with streaming provides compact, modular, 

cost-effective 100 MHz bandwidth signal capture. This 

solution, with its 12-bit IF digitizer, enables long gapless 

capture of signals up to 100 MHz bandwidth to RAID 

storage solutions. It also includes software tools to 

enable signal identification and signal export to analysis 

software such as the industry standard Agilent 

89600B VSA.

 This application note provides:

 Measurement solution overview

 Configuration guidance for storage solutions

 Procedural examples detailing setup and data capture

 Procedural examples using the DataViewer to locate   

 the target data

 Signal analysis example

Int roduct ion

Your  Benef i ts

 Capture intermittent signals and analyze using the   

 M9392A PXI Vector Signal Analyzer with Streaming   

 option

 Easy search capability to look for the target signal of   

 interest

 Thorough analysis capability with the Agilent  

 89600B VSA

 Tips to improve implementation

Appl icat ions

 Aerospace and defense

 Wireless communications

 Radar and wideband signal capture

 Electronic test

Figure 1. M9392A Vector Signal Analyzer system
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How to get the most from Agilent’s M9392A  
100 MHz streaming capability

Measurement  Chal lenge 

When developing RF products—especially those using complex signaling or those expected to make measurements in 
noisy environments—testing may need to address situations where the device under test does not operate as expected.  
Intermittent failure modes make data analysis particularly challenging; and when the root cause of the problem is not yet 

known, it is a challenge for engineers to setup a measurement that captures the failure. 

Widely used standard measurement techniques capture only a few hundred milliseconds of data during each measure-
ment. Intermittent failures can be easily missed due to gaps in the captured data and often the failure using standard test 
methodology cannot be seen. Each time the measurement is reset, there is a gap where data is not captured (Figure 2). 

Figure 2. Acquisition with gaps

Figure 3. Continuous “gapless” acquisition

Another challenge is storing long runs of contiguous measurement data for offline analysis as the standard test meth-

odology can only read as much data as can be held in physical memory . In situations like this, it may be necessary for 

engineers to use tools which enable long captures of gapless data (Figure 3). 

In the absence of an automated process allowing engineers to review a summary of a long streaming record, it is often 

necessary to locate a subset of the data to examine and analyze the target signal. To quickly find the signal of interest, 

engineers need tools they can use to peruse the data and display in multiple domains.

Overview Configure  Solution Setup & Capture Locate Signal Analyze
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How to get the most from Agilent’s M9392A  
100 MHz streaming capability

Measurement  Solut ion Overv iew 

The Agilent M9392A PXI Microwave Vector Signal 

Analyzer with streaming provides a compact, modular 100 

MHz bandwidth gapless capture to the controller or RAID 

storage solution.  

The M9392A includes a graphical user interface to 

control the signal capture, a data viewer to enable signal 

identification and a connection to the Agilent 89600B VSA 

software for thorough data analysis.

Figure 4. M9392A PXI Vector Signal Analyzer soft front panel with streaming enabled

The following pages will provide instruction on:

 Configuration guidance for storage solutions

 Procedural examples detailing setup and data capture

 Procedural examples using the DataViewer to locate the  
 target data

 Signal analysis example

Overview Configure  Solution Setup & Capture Locate Signal Analyze
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Selecting the Storage Capability

During streaming acquisition, data is written to digitizer 

RAM. From digitizer RAM, data is copied to a circular RAM 

buffer on the controller and from this RAM buffer, the data 

is copied to final storage.

To sustain long gapless captures the data must be written 

to the final storage solution faster than the buffer is filled 

with new data. For narrow bandwidth captures, where the 

required data acquisition rate is <40MB/s, or the capture 

time is only a few seconds, a standard computer disk drive 

may suffice for storage. 

For wide bandwidth captures, or where capture duration 

is long (minutes or hours), then a multi-disc RAID storage 

Overview Configure  Solution Setup & Capture Locate Signal Analyze

system is required. The drives that are used in the RAID 

system can vary depending on the measurement environ-

ment.

Solid State Drives (SSD) are useful if the measurement 

environment is susceptible to vibration that could damage 

a standard Hard Disc Drive (HDD). If there are no vibration 

issues, the HDDs provide the most storage memory for 

very long data capture. 

To help in selecting the optimum storage capacity for the 

particular test setup, engineers need to consider all areas 

of the measurement requirements: 

 Bandwidth (BW) required 

 Data rates to support the RF BW 

 Length of time to record the data 

 Physical environmental requirements

Figure 5. Configurations for RAID, Embedded Controller and Desktop PC

How to choose the right 
solution for your needs:

The Agilent M9392A solution can 

be used with either external RAID 

solutions or with the controller’s 

disk drive depending on the data 

needs (Figure 5). 

Step 1: Select your controller of 

choice:

 Embedded Controller M9036A  

 OR

 Desktop Configuration (eg. Dell  

 T3500): Desktop computer from  

 the Tested computer list  

 (http://cp.literature.agilent. 

 com/litweb/pdf/5990-7632EN. 

 pdf)

Step 2: Optionally expand your  

storage with RAID:

 Agilent’s tested and recom- 

 mended storage solutions are  

 from JMR Electronics (see  

 Figure 5 for capacity options)

Agilent’s predefined external RAID 

packages have been tested to 

guarantee sustained data rates 

with the M9392A.  These pre-

defined mass storage packages 

ensure performance when used 

with the recommended controllers. 

 ◦ Capture time:

JMR Model Capture Time

AGIL-G4-8T (HDD) > 3 hours @ 100 MHz

AGIL-G4-16T (HDD) > 6 Hours @ 100 MHz

AGIL-G4-32T (HDD) > 13 Hours @ 100 MHz

AGIL-G4-0.4T (SSD) 10 minutes @100 MHz

 ◦ Disk write time(s): >500 MB/s 

assumes 12 GB RAM ◦ Capture time: ~18 seconds @ 100 

MHz BW  (depending on memory)

 ◦ Disk write time(s): ~40 to 100 

MB/s (depending on the disk 

drive)

 ◦ Capture time: <6 seconds @ 100 

MHz BW

 ◦ Disk write times(s): ~40 MB/s 

assumes 4 GB RAM

M9036A 3-slot Embedded Controller RAID Storage Options (JMR Electronics)Desktop Controller (Dell T3500)

Control ler  and Short  Durat ion Storage
(for  seconds)

Expand Storage with RAID 
( for  hours)

Step 1. Select your controller of choice: Embedded controller or Desktop controller Step 2. Select additional storage (optional)
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Capturing Data Using the M9392A Soft Front Panel (SFP)

Overview Configure  Solution Setup & Capture Locate Signal Analyze

The M9392A Soft  Front  Panel 

The M9392A Soft Front Panel (SFP) provides a graphical 

user interface (GUI) that allows the engineer to control the 

capture of signals connected to the instrument (Figure 6).  

The SFP is ideal when the engineer needs to make quick 

and easy gapless captures, as opposed to programming 

the API to make repeated automated measurements. The 

SFP opens in a standard acquisition mode that is similar 

to standard vector signal analyzers.  Specific controls are 

also available for streaming mode; both the streaming 

and standard modes use many of the same controls to 

setup and trigger the signal being captured or analyzed. To 

access the instrument controls specific to the streaming 

mode, click the “Streaming Enabled” checkbox.

To find an existing file or to specify a new target data 

file,  standard windows file dialogs are used. In addition to 

setting up the instrument, the SFP monitors the data flow. 

To initiate the data capture, click the start button. Once the 

data capture has started, the data flow indicators update 

the user with the data capture process for:  Data Window, 

Acquisition, RAM buffer, and Storage. The Data Window 

provides a spectrum view of the signal being captured.

If an error occurs during the data capture then an appropri-

ate error flag is displayed on the SFP.  The Error indicator 

in the lower right hand side of the window displays more 

error message details.

If the RAM buffer usage increases to 100%, this indicates 

that the data cannot be written to the final storage device 

fast enough to keep up with the data acquisition; in turn, 

this will cause the buffers to overrun and data acquisition 

to stop, since there is no memory available for continuous 

data capture, and an error will be displayed.

Using a high speed RAID system, it is common that this 

buffer is nearly empty since the data can be written to the 

RAID as fast as it is acquired.  

Figure 6. M9392A PXI Vector Signal Analyzer SFP streaming GUI 

when “streaming enabled” checkbox is selected
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Capturing Data Using the M9392A Soft Front Panel (SFP)

Tr igger  and Acquis i t ion Modes

Freerun trigger mode

If the stream of data being captured has continuous bursts 

with only very short gaps, you can use the Freerun trigger 

to begin capturing data as soon as the digitizer is ready. 

Video and External trigger modes 

For sparse data having intermittent bursts and large 

amounts of off-time in the data stream, it could be appro-

priate to trigger the initial data capture on a rising or falling 

edge by using External trigger or Video trigger. The trigger 

event will initiate a single streaming capture.

In Video or External trigger mode, trigger slope, trigger 

level and trigger delay can be set the same as trigger 

modes on other vector signal analyzers. Data during the 

trigger delay time will also be captured and saved to the 

streaming file. For example, a delay time of -1 second 

saves 1 second of pre-trigger data.¹ 

Acquisition modes  

There are two acquisition modes, duration limited or 

unlimited mode. 

 Duration limited mode: an acquisition time in seconds is  

 set.

 Unlimited mode: you must manually start and stop the  

 streaming process using the Start, Stop, or Abort   

 buttons.    

If there is a need to trigger the data, either Video or 

External triggering mode should be used—supported in 

both duration limited and unlimited modes. In duration 

limited mode, when used with a Video trigger or External 

trigger, the acquisition will begin as soon as the trigger is 

received and continues for the duration in seconds set in 

the SFP Acquisition Duration field. If there is a pre-trigger 

data capture, then the total duration of the acquisition is 

the pre-trigger delay plus the capture duration in seconds.

Stop and Abort options 

Pressing the Stop button during an active streaming acqui-

sition will end the acquisition. The data in the RAM buffer 

will then be saved to file.

Pressing the Abort button during an active streaming 

acquisition will end the acquisition and terminate the 

process of saving to file. Data Acquisition and Storage to 

disk will be terminated. Any data written to the drive prior 

to the Abort is retained. 

Triggering the Capture Process using the SFP

The trigger system for streaming is comparable to standard 

vector signal analyzers--the digitizer monitors the external 

trigger input, or for video trigger it checks the power on the 

incoming RF signal.

 

In streaming mode the trigger initiates a data capture to 

file. The generated raw binary data file has an accompany-

ing header file that indicates under what conditions the 

capture was created—a few of the items required to cor-

rectly process the raw binary data are Center Frequency, 

XDelta and YScale. 

Once armed, and in external or video trigger mode, the 

digitizer looks for the trigger event in the sequential data 

blocks it transfers to the M9392A software residing on the 

controller.  When the trigger event occurs, the trigger point 

is marked as an offset from the start of the current data 

block. The capture actually commences from the beginning 

of the digitizer data block that contains the trigger.

1. If a valid trigger occurs within the pre-triggered data window then the 
remaining pre-triggered time is discarded.  
  

Overview Configure  Solution Setup & Capture Locate Signal Analyze
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Capturing Data Using the M9392A Soft Front Panel (SFP)

Figure 7 illustrates the trigger and capture process. XStart in the text header file is the item that indicates the time in the 

streaming record that the trigger event occurred.

Figure 7. Triggering the capture process

Pre-triggering the Capture Process using the SFP

In Streaming mode, if the Trigger Delay is set to a negative value, the value will indicate the maximum amount of pre-

trigger data that can be captured before the trigger event. If the trigger event occurs before the specified trigger time delay 

time elapses, then the process will capture a shorter amount of pre-trigger data as illustrated by Trigger A in Figure 8. If 

the trigger happens after the trigger delay time has elapsed the maximum pre-trigger data will be captured as illustrated 

by Trigger B in Figure 8.  The XStart parameter in the Text header file, shown in Figure 7, will indicate a start time that 

includes the pre-trigger value.

Figure 8. Pre-trigger the capture process

Overview Configure  Solution Setup & Capture Locate Signal Analyze
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Finding Target Data Using the DataViewer

The M9392A DataViewer enables easy search capability to look for the target signal of interest within the stored data file. 

It allows the data to be viewed in different domains and at varying sample sizes.  The DataViewer allows the engineer to 

search through the data quickly until the target data is found. In addition, the M9392A creates streaming files that are 

directly compatible with the Agilent 89600B Vector Signal Analysis (VSA) software.  

For step-by-step instructions see the following page: “Setting up the Data Viewer”.

Overview Configure  Solution Setup & Capture Locate Signal Analyze

Figure 9. Streaming DataViewer Graphical User Interface
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Finding Target Data Using the DataViewer

Setting up the Data Viewer

Steps 1-8 provide procedures for using the M9392A 

DataViewer to load, search and save streaming files. (For 

detailed information refer to the M9392A vector signal 

analyzer user guide).

Overview Configure  Solution Setup & Capture Locate Signal Analyze

Step 1.

When the DataViewer application is opened a dialog 

box opens directing you to “Load M9392A Streaming 

File”. Navigate to the saved file containing the streamed 

data(lfm100MHz_targetSim.bin).

Step 2.

Set sample size or FFT size in frequency domain.

Step 3.

Use the start time controls or the step buttons to move to 

a new start position in the file. 

Step 4.

Lock in the start time in seconds (s) by pressing the button 

below the setting indicator.

Step 5.

Use the start time controls or step buttons to set the 

duration by setting a start time position deeper into the 

streaming file.

Step 6.

Lock in the duration(s) by pressing the button below the 

duration setting indicator.

Step 7.

Set or select the binary output file name.

Step 8.

Click the Save Binary Data button.

End

The new, smaller file is now saved and available for import 

to an analysis tool such as the 89600B VSA.  A real mea-

surement example follows.
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Finding Target Data Using the DataViewer

Radar example

Finding the proverbial needle in a haystack…

Repetitive failure modes can be simpler to diagnose as symptoms are persistent. Intermittent, or even repetitive failure 

modes with a relatively long time between failures, can make data analysis particularly challenging. 

As discussed previously, it is a challenge for engineers to set up a measurement to capture intermittent failures with 

widely used standard measurement techniques which capture a few hundred milliseconds of data during each measure-

ment. Failures can be missed due to gaps in the captured data.

Acquiring a long gapless capture gives a high probability that the failure has been recorded. The following radar example 

illustrates the steps to review a recording that contains a failing event. A radar target simulation has been captured using 

the M9392A SFP then loaded into the DataViewer. The goal is to search through the M9392A streaming file and identify 

the failing event. 

Helpful Hints: 

 FFT Size:  Set the Spectrograph FFT Size to be less than the size in samples of the active data.  Use the IQ graph or  

 Magnitude vs. time graph to make an approximation of the width of the pulse. If the data for a single pulse covers 1024  

 samples the FFT size in the Spectrograph should be set below 1024 for better resolution. Setting the FFT size in the spec 

 trograph to be any more than the width of a pulse makes it difficult to see patterns because the irregularities tend to get  

 averaged out.

 Sample Size:  Set the Spectrograph Sample size to be at least an order of magnitude larger than the FFT Size. This allows  

 more time for the pattern to reveal itself.

 Navigation:  Step through the data set using the forward and backward arrows.

 Adjust:  Fine adjustment may be needed to FFT Size, Sample size or Start Time 

Magnitude Response of a Pulse Train

 This waveform has a characteristic where every 12   

 pulses has a narrower time duration

 The number of samples before the pattern repeats is   

 around 32768 samples

Overview Configure  Solution Setup & Capture Locate Signal Analyze
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Pulse Width in Samples—IQ View

 Use the IQ vs Time graph to find the “On-Time” width of  

 the narrower pulse

 The pulse can be bounded by adjusting in combination  

 the sample size and Start Time

 The bounded pulse is displayed fully by 1024 samples

 The FFT Size in the following Spectrograph should be  

 set to less than the pulse “on time” of 1024 samples  

 A smaller FFT size will provide better frequency  

 resolution 

Radar example (continued)

Finding Target Data Using the DataViewer

Spectrograph of a Pulse Train

This is a spectrograph of the waveform samples shown in 

the Magnitude versus time graph

 The FFT size in this case has been set to 128, while the  

 sample size is the same as the Magnitude vs. Time graph  

 (32768)

 A repeating pattern has been revealed that shows that  

 the narrow pulse also has a reduced positive frequency  

 deviation of less than 20 MHz

Zoomed in Spectrograph ¹

This zoomed-in spectrograph has a response of three 

pulses—the first pulse is narrow.

 Response time axis for each pulse is around 8 steps for  

 the narrow pulse and around 12 steps for the wider   

 pulse

 Narrow pulse: 8 * 128 = 1024 samples

 Wide pulse: 12 * 128 = 1536 samples

 Each diagonal line represents the strongest frequency  

 components of a single pulse over time

 This characteristic is indicative of a Linear FM chirp  

 waveform which is used in this example

1. Note: The Spectrograph can readily detect patterns in the data if the 
FFT Size is set to a sufficient resolution to reveal details in the waveform 
being analyzed.  

Overview Configure  Solution Setup & Capture Locate Signal Analyze
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Analyzing Captured Data with the Agilent 89600B VSA Software

The M9392A creates streaming files that are directly compatible with the Agilent 89600B Vector Signal Analysis (VSA) 

software for further analysis. Data from the streaming record can be loaded directly into the 89600B for detailed analysis.  

Or, smaller segments of the data can be selected using the Data Viewer and this file can then be imported to the VSA 

software.

Steps to load, playback, and analyze captured data using the 89600B VSA software.

Overview Configure  Solution Setup & Capture Locate Signal Analyze

Step 1.

Open the 89600B VSA application 

(note: no hardware is needed to playback the file for 

analysis)

Step 2.

Select File -> Recall Recording

 Using the file open window (Figure 10 ) select the  

 streaming file

 Select the file type as N5110A and click open

Figure 10. Recall Recording Dialog.

Step 3.

Open the playback control: Select Window -> Player

Playback control which allows the user to set file position 

and playback start/stop times.

Figure 11. Player for controlling how recordings are played back

Step 4.

Set the playback trigger: Select Input -> Playback Trigger 

Stable triggering is important to display and measure 

complex data consistently.

Figure 12. Set Playback Trigger

Step 5.

Save option: Create a setup file to easily recall the mea-

surement setup: File -> Save Setup 

Saving the measurement settings allows them to be 

recalled at a later date.

Fi 12 S Pl b k T i
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Analyzing Captured Data with the Agilent 89600B VSA Software

Step 6.

Access measurements

Once the streaming file has been successfully loaded and the playback trigger set, the full suite of 89600B VSA measure-

ments is available for analysis.  Detailed operating information for the Agilent 89600 VSA software can be found by visiting 

the online guide at: http://wireless.agilent.com/wireless/helpfiles/89600B/WebHelp/89600.htm.

Figure 13. Playing back and analyzing the target signal of interest in 89600B VSA measurement.

Summary

In contrast to the benefits offered by wideband communication, the complexity of the technology creates significant mea-

surement challenges. Capturing an intermittent failing signal for measurements using complex signaling or those made in 

a noisy environment is one such challenge.

The Agilent M9392A PXI Microwave Vector Signal Analyzer with streaming allows engineers to dig deep into their signals 

and extract the information they need to identify and isolate physical layer signal problems.

Compatibility with the 89600B VSA signal analysis software ensures engineers have added flexibility to quickly and 

accurately measure and analyze target signals from different perspectives, using advanced techniques. Together, these 

tools provide the fast and accurate solution today’s engineers need to develop, troubleshoot, and optimize their wideband 

solutions.

Overview Configure  Solution Setup & Capture Locate Signal Analyze
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Using the M9392A Streaming file format

A key benefit of the M9392A software is the ability to 

create streaming files that are directly compatible with the 

Agilent 89600B VSA software and make them ready for 

detailed offline analysis. 

Helpful Hints:

 The streaming process in the M9392A software stores  

 the data in binary 16 bit interleaved I/Q, little endian   

 format. This format matches the N5110A binary  

 recording format supported by the 89600B VSA.  

 The M9392A file naming convention is  

 <streamfilename.bin>.

 The same process that creates the binary streaming file  

 also creates a test header file using the naming conven- 

 tion <streamfilename.bin.txt>. This header file provides  

 additional information that describes the conditions   

 under which the data was captured.

Appendix A

Figure 14.  Agilent M9392A PXI Vector Signal Analyzer placed 

within the M9018A PXI Chassis

www.agilent.com/find/pxi-streaming

Header 

Variable

Value Description [Not in header file]

InputCenter 3000000000.0 Indicates the center frequency of the input data in Hz

InputZoom TRUE If Input Zoom is true, the input was zoomed rather than baseband. This implies that 
time data is complex [Always true for IF Digitized data]

InputRange 1 Input Range indicates the input hardware range setting for the data in Volts peak

InputRefImped 50 Indicates the input reference impedance of the data in Ohms [not used by M9392A]

 XStart 0.000 Indicates the time value of first point in data.  If external or video trigger are used then 
XStart represents the time instant within the acquisition that the trigger event hap-
pened. If pretrigger data is captured, then this variable indicates the time in the data file 
when trigger event occurred plus any pre-trigger time

XDelta 1.6e-008 XDelta indicates the time difference between two adjacent points  

The sample rate is (1 / XDelta)

 YScale 1.94985e-005 Multiply the 16-bit I/Q time data by this factor to scale to Volt units
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Configuration and Ordering Information

Mode l Desc r ip t ion
M9392A1 PXI Vector Signal Analyzer:  

50 MHz to 26.5 GHz

M9302A2 PXI Local Oscillator: 3 GHz to 10 GHz

M9360A2 PXI Attenuator/Preselector:  
100 kHz to 26.5 GHz

M9202A2 PXIe IF Digitizer: 2 GS/s, 1 GHz, 50 MHz BW streaming 
(with options -C01, -F02, -M05, -DDS, -V05)

M9202A-V10 PXIe IF Digitizer: 100 MHz BW  
streaming option

M9361A2 PXI Downconverter: 2.75 GHz to 26.5 GHz

M9351A PXI Downconverter: 50 MHz to 2.9 GHz

89601B VSA software 

89601B-200 Basic Vector Signal Analyzer

89601B-300 Connectivity option

89601B-AYA Vector modulation analysis

M9021A PCIe Cable Interface

M9018A 18-slot PXIe Chassis

M9045A PCIe ExpressCard Adaptor

Y1200A PCIe cable: x4 to x8, 2.0m  
(used with M9045A)

Recommended configuration

1. For the M9392A to work properly, at least one PXI chassis and one PXI controller type must be available.
2. Included with purchase of M9392A.
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The Modular  Tangram 

The four-sided geometric symbol that appears in this document is 

called a tangram. The goal of this seven-piece puzzle is to create 

identifiable shapes—from simple to complex. As with a tangram, 

the possibilities may seem infinite as you begin to create a new 

test system. With a set of clearly defined elements—hardware, 

software—Agilent can help you create the system you need,  

from simple to complex.
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